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SECTION 1:  INTRODUCTION TO ARCGIS 9.2

A main component of ArcGIS 9.2 soft ware is ArcMap.  It can be used to create and edit maps and 
analyze spatial data.

1.1 Getting Started

Start ArcMap.  If you do not have an ArcMap icon on your desktop or in your Windows “Start” menu, 
you can locate ArcMap from the Start Menu:

Click on the “Start” menu in the lower left  corner of your screen.1) 

Choose “Programs” or “All Programs” which will cause a submenu to pop up.2) 

Choose “ArcGIS”, which will cause another submenu to pop up.3) 

Choose “ArcMap”.4) 
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In the dialog box that appears, choose to make a new empty map and then click “OK”:

Next, to add data, click on the “Add Data” button ( ) and navigate to where your fi le is stored.  
Click on the fi le you want to use and then click “Add”.  

Here we’ve used the “US_STATES” fi le to add a data layer representing the United States with state 
boundaries.
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Before we go further, notice a few things on your screen: 

2{ 5
4

3 1

When working with map layers, the part of the screen in which the layers are drawn is called the 1) 
data frame. 

Th e column to the left  of the data frame, which shows a list of your data layers, is called the 2) Table 
of Contents.

Th e Table of Contents can show diff erent data about the map layers in your project. You can 3) 
switch modes by clicking on the tabs at the bottom of the Table of Contents. We will be using the 
“Display” mode.

Next to each layer name there is a small check box. If you click it, the layer will turn on or off . You 4) 
can use this to display (or not display) an individual layer.

To the left  of that check box, there is a smaller box showing a + or - character. Th is controls the 5) 
display of the color coding or “symbology”.  (Working with symbology will be covered in Lesson 
1.3: Editing the Legend.)  If the - character is displayed, the color coding (“symbology”) is already 
shown—in this case pink with a black border. If you want to compact your Table of Contents, you 
can turn this off  by clicking on the - , which will hide the symbology.  Click on the + to display the 
symbology again.



MAPPING YOUR COMMUNITY

Introduction to ArcGIS 9.2—Getting Started 1.1.4

02/24/2010

Adding more data

Click the “Add Data” button ( ) again as you did on page earlier to add more layers to your map. 
In the dialog box that appears, double-click a diff erent fi le (or click on it once and then click “Add”).  

Here we’ve added two more layers: “US_CITIES” and “US_COUNTIES”:

Changing the “stack” order

Notice that the soft ware “stacks” the data layers in the map in the same order in which they are listed 
in the Table of Contents. Sometimes one layer will completely cover another. For example, in the map 
above, the US counties are covering the US cities.  

To re-arrange the order in which the layers are displayed, be sure the Table of Contents is set to 
“Display” (you can adjust this via the tabs at the bottom of the Table of Contents).  
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Th en simply click on the layer name in the Table of Contents, hold the mouse button down, and slide 
it up or down. 

Th e map is redrawn with the new stacking order. Now we can see cities on top of the counties:
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1.2 Adjusting Your View

Oft en you will want to zoom in on an area to see the kind of detail you need. For example, if you want 
to see the streets of your city, looking at a map of the whole United States wouldn’t be very useful. To 
look at a smaller area, you need to use the zoom tools.

Zooming in

To zoom in (enlarge a small area to see more detail), select the “Zoom In” tool ( ). When your 
cursor is over the map, it takes the shape of a small magnifying glass with a + symbol. 

Th e simplest way to zoom in on an area is to simply click on the area of interest. Th e map will zoom in 
and center the map on the point where you clicked.

Another approach that will give you more control is to envision a box around the area of interest. 
Using the “Zoom In” tool, click where you would like the upper left  corner to be, hold the mouse 
button down, and drag down and to the right.   
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When the box encloses the area of interest, release the mouse button. Th e map will zoom into the area 
you chose:

Zooming out

To look at a larger area, click on the “Zoom Out” button (  ) and then click the map. Your view 
will zoom out, staying centered on where you clicked. 

Th e example below shows the previous map centered on Missouri aft er two clicks with the “Zoom 
Out” tool:
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Other zoom options

It takes some practice to master the “touch” needed to zoom effi  ciently. 

To go back to the last view you had, simply click the “Go Back to Previous Extent” button(  ). 

If you are much too far in or out, it may be quicker to click the “Full Extent” button (  ). Th is will 
take you to a zoom level that is wide enough to include all of the data layers in the Table of Contents, 
whether they are turned on or not.

Another zoom option is to zoom to a level that shows the extent of a particular data layer. To do this, 
simply right-click on the map layer in the Table of Contents and choose “Zoom to Layer”:

Additionally, the “Zoom In on the Center of your Map” button ( ) and the “Zoom Out on the 

Center of your Map” button ( ), can also be used to quickly zoom in and out.
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 Tip

If you are not panning or zooming, it is a good idea to change from those tools to the 

“Select Elements” ( ) tool.  This helps you avoid accidentally shifting or zooming your map.

Panning

If you are satisfi ed with your zoom, but just need to “slide” the map a bit, use the “Pan” tool ( ). 

With the “Pan” tool selected, click anywhere on the map, and then—holding the mouse button down 
—slide the map into position.  Note: the new area you are panning to will not be displayed until you 
release the mouse button.
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1.3 Editing the Legend

As you make maps, you will want to change the color of the map layers themselves, or change the 
shape, size, or color of the symbols. In many cases, color-coding parts of the map will help in your 
analysis. To make these changes, you will use the symbology controls within the layer’s properties. 

Changing symbology

To change a map layer’s symbology, in the Table of Contents double-click on the name of the layer you 
want to change. 

Th is will open the “Layer Properties” dialog box.

If it is not already selected, click on the “Symbology” tab.
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Th ere are many things to control here; we will focus on only a few. First, we will change how the 
data is colored. In the example map, all states are currently as one color, or what ArcGIS calls “Single 
Symbol.” 

To change the US_STATES layer so that each state shows a diff erent color:

Click on the “Categories” label on the left . 1) 

Choose “Unique Values” when that choice appears (in the “Categories” submenu).2) 

Using the dropdown arrow, choose “STATE_NAME” from the “Value Field”.3) 

Finally, click the “Add All Values” button to populate the small display box with the list of states 4) 
and the colors they are assigned.

If you’d like, you can choose a diff erent color ramp. Your result of your choices is previewed in the 5) 
lower left  side of the box.

When you are satisfi ed with your selection, you can click “OK”. Th e choices you made will take eff ect 
in the map and the dialog box will go away:
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However, for later examples in this tutorial, keeping the states a single color may be a better choice. To 
return the states to a single color: 

Re-open the “Layer Properties” dialog box (by double-clicking on the “US_STATES” layer name 1) 
in the Table of Contents) .

In the “Symbology” tab, choose to show “Features” and then “Single Symbol”.2) 

Choose a color for the states by clicking on the colored box in the “Symbol” section.3) 

To fi nish, click “OK”.4) 
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So far we’ve looked at how to assign a single color to a layer and how to assign a unique color based 
on an attribute. Coloring by unique values is useful when you have descriptive data like names, 
but it can be confusing if you want to show the size or degree of something that is continuous (like 
temperatures, or in the case of hurricane data, the wind speed).

Color coding data

One of the most powe rful tools you have for mapping your data is the ability to use colors to represent 
the data. Th is requires careful thought on your part as you make choices in how to display the data. 
For this example, we’ve added data for 2005’s Hurricane Katrina to the map (instructions for adding 
data can be found on page 1.1.4).  We will now color code the data based on wind speed. 

Open the “Layer Properties” box by double-clicking on the “katrina” layer name in the Table of 1) 
Contents. 

In the “Symbology” tab, choose to show “Quantities” and then “Graduated Colors”. 2) 

For the “Value” fi eld, choose “SPEED” to color code based on the magnitude of the earthquakes. 3) 

Change the color ramp if you prefer. 4) 

Click “OK” to have the changes take eff ect.5) 
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Another option to consider is to code the data with graduated symbols rather than graduated colors. 
You could use larger dots to signify greater wind speed, for example.
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SECTION 2: DOWNLOADING AND PROCESSING DATA

2.1  Joining Data Tables

Many times you will fi nd a table of data that you want to map, perhaps as an Excel spreadsheet or on 
a web page. If you have a shapefi le that has the relevant geography, you can join the two pretty readily. 
For example, a table of data with crime statistics by zip code can be joined to a zip code shapefi le, 
allowing you to map the data.

In this example, we will map the demographics of Shelby County (including Memphis), Tennessee.  
More information on how to access this kind of data is included on page 2.1.9.

Mapping the base shapefile

In ArcMap, create a new map.  Add the shapefi le with the relevant geography—in this case a map

of Shelby County, Tennessee—by clicking on the “Add Data” button ( ) and navigating to the fi le.  

If you’d like to see what data you have available in this shapefi le, right-click on the layer name in the 
Table of Contents, and then click “Open Attribute Table.” 
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Notice that the table contains primarily just coding to identify each block group—nothing much of 
interest here:

You can close the Attribute Table window now.

Adding data from a table

If you have information in a table for the area you just mapped, you can add this data to your map.

Right-click the layer name in the Table of Contents.  Choose “Joins and Relates” from the popup 
menu, and then choose “Join” from the submenu. 
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In the fi rst box in the Wizard that appears select “Join attributes from a table.”  

You are going to make the join based on columns that your base map layer and your data table 1) 
have in common.  In this example, we will choose the STFID column since this identifi es each 
census block group in the country uniquely.

Click on the small folder icon and navigate to where you saved the table fi le. When you have 2) 
found the fi le, select it and click “Add.”

Next choose the fi eld in the table that corresponds with the base layer’s fi eld you chose in step 3) 
1.  In this case, the fi eld is again called STFID, but the column headings don’t necessarily have to 
have the same names in both tables. Th e key is for each record in each table to match up one to 
one, regardless of what the columns are called.  (For example: one column might be called STFID 
and the other census_block_group_id.)

1 Step  3

2 Step  3

3 Step  3

Click the “OK” button at the bottom and ArcMap will join the data for you. When asked, allow 
ArcMap to index the data.
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If you right-click on the block group layer again and choose “Open Attribute Table,” you can see many 
fi elds of useful demographic data attached to the layer. 

Notice also that each column now has a label showing from which fi le the data originated (e.g. 
tn_demog). Th is can be helpful if you need to trace the origin of data you are analyzing. It also allows 
data fi elds from both tables with the same name to be used.
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1 Step  3

2 Step  5

3 Step  4
4 Step  4

5 Step  3

Mapping the combined data

To map the demographic data, simply double-click the layer name in the Table of Contents to open 
the Layer Properties dialog box.

In the “Layer Properties” box:

Choose the “Symbology” tab1) 

In the “Show” section, click “Quantities” and then click “Graduated colors.”2) 

Now look at the “Fields” section.  In this case, I’m choosing fi elds from the dropdown menu so 3) 
the  map will show the Black population (tn_demog.BLACK), divided (normalized) by the total 
population within each block group (tn_demog.POP2000).

Under Classifi cation I want fi ve levels or 4) classes.

You can adjust the Color Ramp to whatever colors you desire. 5) 

Click “OK” close the dialog box and see the mapped data.  



MAPPING YOUR COMMUNITY

Downloading and Processing Data—Joining Data Tables 2.1.6

12/15/2009

In this case, it shows distinctive segregation patterns:
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Saving the combined data as a shapefile

Th e data you just joined will not automatically be kept together; you need to make the join permanent 
by  making a new shapefi le.  

Simply right-click on the original layer’s name in the Table of Contents, choose “Data” from the 
popup menu, and then “Export Data” in the sub-menu. 
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In the dialog box that appears, choose to export “All features” and use the same coordinate system as 
“this layer’s source data.”  Th en choose a name and location for the new shapefi le and click “OK.”
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Getting the data

You can map similar data for your county by downloading the data from http://arcdata.esri.com/
data/tiger2000/tiger_download.cfm. 

From this web page choose your state via the dropdown box or the map. On the next web page 
choose the county you want and click the “Submit Selection” button below the county dropdown 
box:



MAPPING YOUR COMMUNITY

Downloading and Processing Data—Joining Data Tables 2.1.10

12/15/2009

Now you need to check the box or boxes next to the data layer or layers you want to download.  
Th en click “Proceed to Download.”

For this example, I downloaded the block groups (this is a map of the county) for the year 2000 
and the SF1 demographics for block groups:

Once you have this data downloaded, unzip the zip fi les and save the extracted fi les somewhere 
easy to fi nd.  You may want to rename the fi les to something more straightforward.  

In this case, I’ve changed the name of all block group fi les from “tgr47157grp00” to “tn_shelby_
cnty_map” since it is a map of Shelby County, Tennessee.  (All three fi les from this zip group 
must be changed to the same thing, without changing their fi le type extensions: .dbf, .shp, .shx.)  
And I renamed the “tgr47000sf1blk” fi le “tn_demog” since it is the demographic information 
for the entire state of Tennessee.
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2.2  Managing .e00 Files

Many times, the geospatial data you download will be in an export or interchange format. Th ese are 
fi les that end in .e00. Please note that you will usually need to “unzip” fi les you download from the 
internet before processing them as described here. Zipped fi les typically end in a .zip or .gz. Th us, you 
could have fi lename.e00.gz to begin with. Unzip the fi le using any of a wide range of utilities designed 
for that purpose and you will be ready to proceed.

In this example, we will be preparing a road map for the city of St. Louis, Missouri. Th is was 
downloaded from the Missouri Spatial Data Information Service (http://msdis.missouri.edu/).  Once 
you have located and successfully downloaded (and unzipped, if necessary) your .e00 fi le, you need to 
perform at least one more step in processing it for use in ArcMap.

To process an .e00 fi le, start ArcCatalog. If you have ArcMap open, click on the “Tools” menu and 
then select “ArcCatalog.”
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In ArcCatalog, click on the “View” menu.  Choose “Toolbars” from the popup menu and then choose 
“ArcView8x tools” from the submenu:

You will get a small, dockable window.  From its pull-down menu, choose “Import from an 
Interchange File:”

In the dialog box that appears, navigate to the .e00 fi le you downloaded earlier as the input fi le. 
Clicking on the folder icon will let you change your folder location to the one holding the .e00 fi le.

Similarly, navigate to the directory in which you want to place the output dataset, and assign a name 
for the fi le.  When this is done, you can click “OK” and the fi le will be converted to a coverage fi le that 
can be mapped. Note: there can be no spaces anywhere in the path names.
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Th e new coverage will now be available for mapping in ArcMap. 

In ArcMap click the “Add Data” button(  ).  Choose the fi le from the “Add Data” dialog box 
(make sure you are choosing the coverage fi le from among the fi les with the same name—look in the 
“Type” column to see the fi le types).  

Click “Add” and the data is mapped:
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Converting the coverage into a shapefile

For ease of use, you may want to convert this coverage into a shapefi le. A shapefi le allows you to re-
project the data, and makes it easier to move the fi le around.

To make a shapefi le, right-click on the layer name in the Table of Contents, choose “Data” from the 
popup menu, and then choose “Export Data” from the submenu:
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In the “Export Data” dialog box choose to export “All features” and then use the same coordinate 
system as “this layer’s source data.”  Finally select a location and fi le name for your new shapefi le and 
click “OK.”
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2.3  Importing Imagery

You may want to add an aerial photograph or topographic map to your project.(Instructions on how 
to get and prepare imagery can be found on page 2.3.4.)  As a fi rst step, it will be necessary to defi ne 
the projection that will be used in the data frame so that it matches the projection of your imagery.  

Open ArcMap.  In the Table of Contents right-click “Layers” and then choose “Properties.” 
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In the “Data Frame Properties” dialog box that appears, click on the “Coordinate System” tab, and 
navigate to the coordinate system used by your raster image, in this case NAD 1983 UTM Zone 15N.  
Once you have chosen your coordinate system click “Apply” and then “OK.”

Th e coordinate system for an aerial photo will typically be UTM, with the zone determined by where you 
are located on Earth (U.S. zone map available at http://www.tinyurl.com/UTMzones).  (UTM is located 
under Predefi ned  >  Projected Coordinate Systems; more information on coordinate systems and defi ning 
projections can be found in section 3.1.)
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In ArcMap, click on the “Add Data” button ( ) from the general toolbar, and navigate to the raster 
image fi le (the .jpg fi le). You can now add it to your project, along with other data.

Note: if you want to plot coordinates on an image, see section 4.4 for special projection instructions. 
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Finding and preparing imagery

Th e Microsoft  Research Maps web site ( http://msrmaps.com) off ers aerial photography and 
topographic maps for use in mapping projects. Both of these types of data are oft en called raster 
imagery. Following these steps will help you to locate and download the raster you need. 

First, at the Microsoft  Research Maps site, at the upper left  corner of the web page, enter a 
location for which you want an aerial photo or topographic map. Th en click the “Go” button.  

Th e site will return the choices available for that area.

Select one and it will appear in a window within the web site. Be sure to note how current the 
photo or topographic map is—quite oft en it can be a decade or more old, which may aff ect its 
usefulness.
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Note that aft er your image or map is chosen, you can further navigate north, south, east, or west, 
and zoom in or out to alter the scope of your selection.

Once you have fi nalized your selection, click on the “Download” option in the top right corner 
of the image box. Th is engages processing on the server, preparing the photo for your use.

Once the photo is restored on screen, simply right-click on it and choose “Save picture as…” or a 
similar command for the browser you are using.

Save the image in JPG format (with the .jpg fi le ending) in a location you will remember. 
Remember that ArcMap handles the Desktop and My Documents locations poorly. Pick another 
place if you can.

Once you have saved your image, choose the “World File” option which has now appeared in the 
top right corner of the image box. 
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A series of numbers will appear in a new browser window. Copy and paste these numbers into 
a new Notepad fi le.  Save the fi le with same fi le name you used for the image earlier, except now 
the ending must be “.jgw”.  

Th ese two fi les must be stored in the same folder.

Double-check that your two fi les have the same names and have the fi le endings .jpg and .jgw.  
You can do this by navigating to the folder using Windows Explorer.  Before adding the photo 
to your project, be sure your world fi le was saved properly and that no extra fi le type ending was 
added aft er the .jgw. 

Microsoft  Research Maps fi les use NAD 83 UTM as their coordinate system. You will need to 
add a zone. (See zone map available at http://www.tinyurl.com/UTMzones).  St. Louis, Missouri 
is in zone 15.  Th us the projection for this image is NAD 83  UTM Zone 15N.  (Th e “N” stands 
for north because it is in the Northern hemisphere.)
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SECTION 3: ADVANCED DATA MANAGEMENT

Occasionally, this doesn’t work, however, and a projection must be defi ned for one or more map 
layers. You know this is the case when ArcMap returns a message such as this:

When you encounter this, a projection must be defi ned for that layer to be used properly.

To do this, start ArcToolbox by clicking on the small toolbox icon ( ) in ArcMap.

3.1  Defining Map Projections

ArcMap generally does an adequate job of “projecting 
on the fl y,” or making the necessary translations between 
diff erent projections. Th is allows data from diff erent 
projections to be mapped in the same project. When a 
projection is being done “on the fl y,” you will receive a 
message like the one below, but in most cases the accuracy 
will be suffi  cient for your purposes.

What is a map projection?

A map projection is used to portray 
all or part of the round Earth on a 
fl at surface. This cannot be done 
without some distortion.

Every projection has its own set 
of advantages and disadvantages. 
There is no “best” projection.

The mapmaker must select the one 
best suited to the needs, reducing 
distortion of the most important 
features.

From the USGS web page “Map 
Projections.”  (http://egsc.usgs.gov/isb/
pubs/MapProjections/projections.html)
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Within ArcToolbox, double-click “Data Management Tools” to expand that menu, then double-click 
“Projections and Transformations,” and fi nally, double-click “Defi ne Projection”:
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Th is opens a wizard that will guide you through the process. 

In the fi rst box, specify the map layer (known formally as the dataset or feature class) by clicking on 

the folder icon ( ) and navagating to the fi le.  

In the second box you will specify the coordinate system.  (Th e coordinate system should be known or 
available from the source of the data. If not, you will need to contact the data provider.) 

Sometimes the coordinate system will automatically fi ll in when you specify the map layer.  If it fi lls in 
for you, the projection is already assigned.  Click “Cancel” to close the dialog box.

If the coordinate system does not automatically fi ll in, you will have to specify it. 

To specify the Coordinate system, click on the small icon ( ) to the right of the box. 
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Th e “Spatial Reference Properties” dialog box will pop up, and you can select one of three common 
options:
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1)  
If you opt to select the coordinate system, you will need to navigate to an appropriate geographic 
or projected coordinate system. At the risk of over-simplifi cation, the geographic coordinate 
systems use a latitude / longitude system that assign every point on Earth a unique coordinate. 
In other instances, usually for maps covering a smaller area, projected systems are used. In either 
case, selecting the appropriate coordinate system is a matter of navigating through the folders to 
fi nd the appropriate choice.

2) 
If you choose to import a projection already used by another shapefi le, you will be prompted to 
locate the layer with the projection you want to use. When the data fi le has been located, simply 
double-click on it or click it and then click “Add.” Th is will assign the projection of the shapefi le 
you just chose to the unprojected one.

3) 
If you need to defi ne a new coordinate system not available in the selections covered in the fi rst 
two options, you will need the relevant data from the data provider to complete the dialog box. 
(Note that this is very rarely needed; in almost all cases one of the other two options above is the 
right choice.)

Whichever of the three options you use, click “OK” when you have completed the “Spatial Reference 
Properties” dialog box.  Th en click “OK” to close the “Defi ne Projection” dialog box, and a projection 
will have been defi ned for the layer.
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3.2  Clipping Data Layers

Many times you will want to use a smaller part of a layer (like only the roads in one school district or 
town, not the whole county). Th is technique, called “clipping,” is pretty easy to use.

Clipping Out Part of a Layer

To clip out part of a layer, you actually need two layers: the one you are clipping and the one that 
provides the boundaries of the “clip.” 

In this example, we’ll clip out the roads for one school district from the larger county road layer. 
Metaphorically, the school district boundary will be the cookie cutter and the road layer the dough. If 
you need to make the cookie cutter fi rst, see the suggestions on page 3.2.3.

Within ArcMap, open ArcToolbox by clicking on the small red toolbox icon (1)  ).

In ArcToolbox, double-click “Analysis Tools,” double-click “Extract,” and fi nally double-click 2) 
“Clip.”  Th is will open a dialog box where you can choose the layers you need. 
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In the “Clip” dialog box, choose the input features (the County Roads in this case) and the clip 3) 
features (the Kirkwood school district). If the layers aren’t already loaded into the project you are 
working on, you can navigate to them by clicking on the folder icons next to each feature.

Choose the name and location for the output layer.4) 

When you click “OK ,” your clipped layer is created. Th e program will pop up a new window 5) 
showing the progress of your clipping operation. When the clipping is complete, close the dialog 
box and you will see your layer in ArcMap. 

You can turn off  the county-wide road layer if you like, and zoom into your new layer by right-6) 
clicking (in the table of contents) on the layer name you just created and choosing “Zoom to 
Layer.”

12/15/2009
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Making a Good “Clip Layer”

Many times you won’t have the specifi c area you are interested in as a separate layer ahead of time. 
In the example above, the Kirkwood School District clip layer started as a layer containing all of the 
school districts in St. Louis County. Just a few quick steps created a new layer that only contains the 
Kirkwood district.

From the Selection menu, choose “Set Selectable Layers.” In the dialog box that appears, uncheck 1) 
all of the layers except the one you are interested in (school districts in this case).

Choose the Select Features tool (2)  ) from your tool palette.

Click and drag a small box in the area you want to select.  Be sure your box does not go outside 3) 
the boundaries of the area you want in your clip layer. Th e selected parts will be highlighted in 
cyan blue. If you accidentally select too much, you can go back to the Selection menu and choose 
“Clear Selected Features.” Th en try your selection again.
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In the Table of Contents, right-click on the layer containing the selected features, and choose 4) 
“Data” and then “Export Data.” 
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In the dialog box that appears, choose to export “Selected features.” Use the same coordinate 5) 
system as “this layer’s source data.”  Th en choose a name and location for your new fi le.  ArcMap 
automatically calls the new fi le Export_Output.shp.  You should rename it to something that 
makes sense (although leave the .shp ending intact).  When you are fi nished renaming click “OK.”

When asked, add the exported data to your project.6) 

You can then proceed with the clipping operation with the layer you just created.
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3.3  Merging Data Layers

Th ere will be times when it will be useful to have more than one layer combined into a new layer. In 
this example, road layers from St. Louis city and county will be combined into one new layer.

Within ArcMap, open 1) ArcToolbox by clicking on the small red toolbox icon (  ).

In 2) ArcToolbox, double-click “Data Management Tools” and then double-click “General.” Th is will 
reveal a number of tools; double-click “Merge.”
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In the dialog box that appears, choose at least two input layers. To choose layers that have already 3) 
been added  to your project, click the small dropdown arrow next to the box.  Choose the layers 
from the list that appears. 

If you need input layers that are not part of your project you can choose them by clicking on the

 folder icon  ( )and navigating to the layers you need.



MAPPING YOUR COMMUNITY

Advance Data Management—Merging Data Layers 3.3.3

12/15/2009

Give your new layer an appropriate name and location, using .shp as your fi le type.  Click “OK.”4) 

You can now use your new layer.
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SECTION 4:  PLOTTING LOCATIONS

For many projects you will want to plot individual street addresses on a map. Th ere are several tech-
niques that can be used. 

4.1  Plotting Single Addresses on a Map

If you have an individual address that you simply want to pinpoint on a map, you can use the “Find” 
tool to have the ArcGIS soft ware mark your desired location.

Once you have your street map displayed, choose the “Find” tool 1)  .

In the Find dialog box that appears, choose “Addresses” from the tabs at the top of the box. 2) 

In the Address Locator pulldown menu, choose the “U.S. Address Finder Tele Atlas” option.a) 
Enter the address you are interested in. Usually a street and zip code are suffi  cient. b) 
Click “Find.”c) 
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Matches will appear at the bottom of the dialog box. Right-click the one you want and choose 3) 
“Add Graphic” ( ). 
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Th is will place a small dot at the geocoded location. Th e dot will stay in the correct location as you 
zoom in and out or pan around the map.

Th is technique is easy to use for locating addresses, but it is limited in that you can only identify the 
location. Th ere are no attributes with the dot that you can use to color code based on an attribute, like 
you can with most geospatial data.
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4.2  Preparing Multiple Addresses for Plotting on a Map

If you have several addresses to plot, you can simply repeat the directions in section 4.1 as many times 
as needed. Th is may be cumbersome if you have many addresses, however, and you are still limited to 
displaying a dot. A more powerful option is to use a batch geocoder that will process many addresses 
at once and give you more options once you have your points located.

To use this option, go online to www.gpsvisualizer.com/geocoder. From there, type in the addresses 
you are interested in geocoding:

Click the “Start Geocoding” button and aft er a brief wait, your results will appear in a text fi le below a 
map of your points.  

Copy and paste the results into Notepad  or another text editor and save the fi le as a comma separated 
value (.csv) fi le.  Th ese points can then be plotted just as if they were GPS coordinates. (See section 4.3: 
Plotting GPS Coordinates, page 4.3.2.)
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4.3  Plotting GPS Coordinates

For many projects you will want to plot coordinates.  First you must set the projection of your map.

Aft er you have set the projection for your map, put the coordinates (from a GPS receiver or other data 
source) into a table. 

You can use Notepad or any other simple text editor to do this.  In the fi rst line type in the data 
headings separated by commas.  Type the data in subsequent lines in the same order as the headings, 
again separated by commas:

Setting the projection

Before plotting your GPS data, be sure that the projection of your map view has been set. To do this, go 
to the View menu and choose “Data Frame Properties.”

Within the dialog box that appears, choose the “Coordinate System” tab. In the box near the bottom 
of the dialog box, choose the coordinate system your map is using. In almost all cases this will be a 
“predefi ned” cooordinate system. 

Geographic Coordinate Systems • use latitude-longitude values. One good choice is WGS 1984 
(navigate to it by clicking Predefi ned > Geographic Coordinate Systems > World > WGS 1984).  

Projected Coordinate Systems•  use x, y values.  Among Projected Coordinate Systems, both State 
Plane and UTM are very useful.  

The choice of projection is very dependent on the data you have and the location with which you are 
working.  For our purposes, set the projection to WGS 1984 unless you know your data is in a diff erent 
projection.

(Note: when combining imagery, such as aerial photos, with coordinates, special instructions apply.  

See section 4.4.)

When the coordinate system has been selected, click “Apply” and then “OK.”

You can then return to the main ArcGIS interface to map your points. 

Aft er you have entered your data, save the fi le as a comma separated value (.csv) fi le.
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Within ArcMap, make the base map as you normally would, with whatever layers of data are 
appropriate. Th en, from the Tools menu, choose “Add XY Data.”  

In the dialog box that appears, click the small folder icon ( ).  Navigate to where you have saved 
the .csv fi le, select it, and click “Add.”

You should see that the fi le has been selected, and ArcGIS has made an eff ort to identify the X and Y 
coordinates of your data:
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(You don’t need to be concerned about the Unknown Coordinate System shown in the Description section 
of the dialog box, or the warning you receive aft er you click “OK.” We’ll take care of that in a minute by 
exporting to a shapefi le.)

As a last step in this process, click “OK” and you will see your points plotted on your map:

Notice that your new points appear in the Table of Contents (to the left  of the map) as an event. To 
be able to edit this layer later, you will want to make it into a “regular” data layer. You can do this by 
exporting it to a shapefi le (see below). 

Exporting to a shapefile

Right-click the layer in the table of contents, choose “Data” from the popup menu, then select “Export • 
Data” from the submenu.
Click the “Export” drop-down arrow and select “All features”• 
Select the output coordinate system you want to use. (In this case we will use “this layer’s source data”.) • 

Click the Browse folder icon (• ) to navigate to a location to save the exported shapefi le.  Name 
your fi le and save it as a shapefi le (.shp).  Then click “OK.” 
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4.4  Combining Imagery and Coordinates

Sometimes you will want to map both coordinates and an image.  Getting the projections of the two 
to work together can be a challenge.  Th is tutorial will walk you through one way to map the data.  

Getting the image set up

First, open ArcMap and begin a new map.

Click on the add data ( ) button.  Navigate to and select the image you want to map (such as an 
aerial photo). (Instructions on fi nding, preparing, and downloading aerial photographs and topographic 
maps can be found in the section on importing imagery: 2.3.4.)

In the example, an aerial photo of Ladue, Missouri was added.  

Next, we need to set the projection. To do this, click “View” and then click “Data Frame Properties” in 
the pop-up menu. 
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In the “Data Frame Properties” dialog box that appears, go to the “Coordinate System” tab.

Here select whatever coordinate system was used by the image.  For the example, knowing that the 
coordinate system for the image is NAD 1983 UTM Zone 15N, choose:

Predefi ned  >  Projected Coordinate Systems   >   Utm   >  NAD 1983  >  NAD 1983 UTM Zone 15N

Click “OK” to set the coordinate system, close the box, and return to the map
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Adding the coordinates

From the “Tools” menu click “Add XY Data…”

In the dialog box that appears, click on the folder icon ( ) and navigate to the .csv fi le you want to 
use.  (Instructions on saving coordinates as a .csv fi le can be found at 3.3.1.)

Th e X Field and Y Field sections should fi ll themselves in with Longitude and Latitude respectively:

Click “OK.”  
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You may get an error box that your table does not have an Object-ID fi eld.  We will fi x that in a 
moment.  Click “OK” to close the error box.

Create a shapefile from the coordinate data

Right-click the .csv fi le name in the Table of Contents, then click “Data” and “Export Data…”
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When asked, add the new shapefi le to your map as a layer:

In the “Export Data” dialog box that appears, choose to export “All features” and use the same 
coordinate system as “this layer’s source data.”  Select a fi le location and name for your new shapefi le 
and click “OK.”

Back at your map, right-click on the .csv fi le name in the Table of Contents and then click “Remove.”
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Setting the projection of the new shapefile

Open ArcToolbox by clicking on the ArcToolbox icon ( ) or by clicking on “Window” and then 
clicking on “ArcToolbox.”

In ArcToolbox double-click on “Data Management Tools” then double-click “Projections and 
Transformations.”  Finally double-click “Defi ne Projection.”
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In the “Defi ne Projection” dialog box, use the drop-down arrow or the click the folder icon ( ) 
next to the “Input Dataset…” box to navigate to the fi le for which you want to defi ne projection (in 
this case the new shapefi le “gpscoordinates”).  

Th en click on the  icon next to the “Coordinate System” box.  In the dialog box that appears, 
click the “Select” button.  Th en double-click:

Geographic coordinate system  >  World  >  WGS 1984.prj

Click “OK.” 

Your “Defi ne Projection” box should look like this:

Click “OK.” 

Aft er a moment, the coordinates will appear in the correct location on your map:
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